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Introduction

Thank you for purchasing Network Video Recorder VK-64 v1.3 (hereafter referred to as “VK-
64”). VK-64 is a network video recording and monitoring system and consists of the Storage
Server and Viewer. This manual explains how to use the Viewer. Please read this manual
prior to operation to ensure you will be able to use the Viewer and Storage Server effectively.
This manual also explains how to use the Network Video Recorder VK-64 v1.3 and Viewer-
Only use. When you have finished reading this manual, please store it in a safe place.

* VK-16 has the same functionality as VK-64 outlined in this manual, unless explicitly indicated
otherwise.

Request to Customers

(1) Canon owns the copyright of this manual. The content of this manual may not be reproduced in
its entirety or in part without prior permission.

(2) The content of this manual is subject to change without notice.

(3) All possible measures have been taken to ensure that the content of this manual is accurate. If
you happen to notice errors, omissions or other faults, please contact your vendor.

(4) Irrespective of items (2) and (3) above, Canon cannot bear responsibility for any effects that
result from operation.

(5) When description of this manual uses the Control Panel, it conforms to operations with Window
XP Classic style.

Request to Customers (Indemnity)

Software defect may cause an error in recording and damage or loss of recorded data.
Canon cannot bear responsibility for any effects that result from operation. You should
agree with it before using the product.

(" Support Information N
For various types of information relating to support, including updated product software (patch installer),
User’s Manual, operating environment, etc., please refer to our WebView Product web page:
canon.com/webview

- /
4 Copyright Information b
Please note that copyright laws prohibit the customer from using recorded videos and still pictures for

any purpose other than personal requirements, without permission from the copyright holder.
- /
Trademarks h
® Canon and the Canon logo are registered trademarks of Canon Inc.
® Microsoft Windows is a trademark of Microsoft Corporation in the United States and other countries.
® Windows is legally recognized as Microsoft Windows Operating System.
® QuickTime is a trademark of Apple Computer Inc.
® Apache is a trademark of the Apache Software Foundation.
® Pentium is a trademark of Intel Corporation.
® All other company or product names used in this manual are trademarks or registered trademarks of
\___their respective holders. J
" N

Icons Used in this Manual

E Indicates important information that must be observed or actions that are
prohibited during an operation. These notes must be read to prevent possible
Note faults or errors during operation.

@ Indicates supplementary information or a reference to an operation. Users are
‘” advised to read these memos.

N J
Storage Server includes software developed by the Apache Software Foundation (www.apache.org). Apache software is
protected by the copyright law (Copyright(c) 2000-2003 Apache Software Foundation). For the license terms associated with
this software, please refer to the file APACHE_LICENSE in the folder LICENSE, within the installation directory.
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Overview

VK-64/VK-16 is a network video recording and monitoring software and consists of
the Storage Server and Viewer. The Storage Server can record videos and events
(sensor input and motion detection) data from multiple camera servers. The
Viewer can display videos from multiple camera servers in real time and play back
videos recorded on the Storage Server.

This manual explains how to use the Viewer.
The Viewer can be used by itself without connecting to the Storage Server (Some

functions such as video recording, sensor events, and motion detection Capture
Still Frame are not available) (— P. 13).







Chapter |

Using the Viewer -

Operator Login

This chapter outlines how to start the Viewer and
gives a brief overview of the Viewing Screen.




Viewing Screen Example

Location selector (— P. 18)
Drop-down menu indicating
locations available in the
system.

Zone selector (— P. 18)
Drop-down menu indicating
zones within a location.

Camera Control Panel

(— P. 27)

A range finder enables you to
control a camera and quickly
determine a camera position.

Event indicator (— P. 25)

A color bar is displayed at the
top of live Video Windows
when an event occurs (if
enabled).

Viewing Area for Video
Windows (— P. 14)

The Video Windows are
arranged here. Video Windows
can be re-sized.

They can also be arranged into
a uniform grid.

Video Window (— P. 20)
Recorded videos and live
videos are displayed in these
windows.

Camera Name (— P. 38)
Name of camera currently
selected.

Playback controls (— P. 38)
Click the VCR-like controls to
play, rewind, fast forward or
jump to previous and next
events.

Timeline control (— P. 38)

Scroll forwards through the
current day or jump forward
incrementally by day or week.

Timeline (— P. 38)

Paste date and time as well as events which
occurred are displayed here. Events are displayed Click to initiate a

Menu bar (— P. 15)

Access common menus
from here.

2, Network Yideo Recgrfer YK-64 - Storage Server

File Edit Wiew Help

Checkout Area

Location
Shopping Mall -

Zone

Record Now button Capture Still Frame
(— P.42) button (— P. 42)

Click to save the current

as bars colored according to the priority. Click and manual recording with a image on a Video

drag the Time bar to go back or forwards in time.

duration of one minute. Window.



Viewing Screen Example

Camera Selection Area (— P. 18)

Thumbnail representations of cameras added to each zone are displayed here.
These can be dragged onto the Viewing Area for viewing.

hation

Motion

& Event Search  Jump to Time h Return to Live %

Timeline playhead (— P. 40)
Click and drag to positions on the Timeline to show
video from that time.

Video Window menu icon
(—P.31)

Select preset camera angles,
custom pan, tilt and zoom, and
select a Video Window size.

Live Events Log list (— P. 45)

Indicates events that have
been logged on Storage
Servers after the Viewer was
launched.

Zoom In and Zoom Out
buttons (— P. 38)

Click to zoom in or out of the
Timeline.

Event Search button

(— P. 47)

Click to bring up a dialog and
enter search details based on
time range, Location/Zone and
priority.

Jump to Time button

(— P.41)

Click to enter a specific date
and time to jump to, to start
playing recorded video. The
Timeline moves to the time
selected.

Extract Video button

(— P. 44)

Click to extract a segment of
video to save as another file.

Return to Live button
(— P. 44)

Click to return the Timeline
playhead to the current time. If
you click this button while
playing recorded video, the
selected Video Window will
return to live video.

Timeline control (— P. 39)
Scroll forwards through the
current day or jump forward
incrementally by day or week.
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Starting the Viewing Screen

Before you use the Viewing Screen, make sure you have the user
name and password. Ask your System Administrator for the user

Note  name and password.

Launching Procedure

Before you launch the Viewer, make sure your monitor resolution is set to a minimum of
1024 x 768 pixels.

Step 1: Start the Viewer

@ Double-click the VK Viewer desktop icon.

WE Wiewer
Alternatively, from the Windows Start menu select: Programs > WebView
Livescope > Network Video Recorder VK Series v1.3 > VK Viewer.

The connect option menu (Start-up Screen) is displayed. Select Master Storage
Server option and click Connect.

Start-up Screen

localhost

Network Video Recorder Connects to Storage
VK-64 v1.3 T Server and starts the

o Viewer. Select this option
if you want to use the
local PC where Viewer is
installed as the Master
Storage Server.

Use IP address

Connects to Storage
Server and starts the
Viewer by specifying its IP
o o address. Select this option
_coned | when the Storage Server
and the Viewer are
installed on separate PCs.

Camomn @ Copyright 2007 Canon Inc.

Not use Storage Server
Select this option to use
the Viewer only without
connecting to a Storage
Server.

-D- If a connection error occurs, you may not have a Master Storage
N

Tip Server connected. Ask your System Administrator.




Starting the Viewing Screen

Connect to the localhost

If you want to use the local PC where Viewer is installed as the Master Storage Server,
select localhost to start the Viewer.

Step 1: Connect to localhost

Master Storags Server 1 Select localhost from the

> Cantel | dl’Op—dOWl‘l menu.

Click Connect.

Step 2: Login

_ x| Enter your User Name and Password, and

click Login.
Please enter your user name and password,

User Lagin

User Mame I |

Password I

( Login I ) Cancel |

ﬁ The user name and password for the VK-64/VK-16 entered in this

step are defined by your System Administrator on the he Storage
Server Configuration dialog. They can be different from the user
name and password used to log into Windows.

Note
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Starting the Viewing Screen

Specify the IP address of Storage Server to connect Viewer

If you installed the Viewer and Storage Server on separate PCs, specify an IP address of
Storage Server and connect Viewer to the Storage Server.

If you are unsure of the address to use, ask your System Administrator.

1 Select Use IP address from
Master Storage Server ’WI the drOp—dOWn menu.

<z Cancel |

2 Click Connect.

X Enter the IP address or host
Flease enter the Master Storage Server settings below, 3 name Of the Master Storage
Master Storage Server Server in Host Name or IP,

Pt [0 and the port number in Port.

Host Mame ar IP

Click Connect.
oo | 4
onnect Cancel I

Enter your User Name and
x| 5 y Name
Password, and click Login.
Please enter wour user name and password,

User Login

Liser Mame ||

Password |

C Login I ) Cancel |
® If you need to use a proxy server, you need to change the
N Internet option settings in the following procedure:
ote

1. Select Start > Control Panel > Internet Option.
2. Select the Connection tab.

3. Click LAN settings ....
Change the proxy server settings.

@ If using a proxy server between a Viewer and a Storage Server,
it should be one which does not perform response buffering.
Proxies which are configured to perform response buffering
may lead to delays in sending small amounts of data (such as
events) from the Storage Server to the Viewer. The Apache
proxy server does perform response buffering so is not
recommended.

® You cannot transmit or receive audio when using a proxy
server.




Starting the Viewing Screen

-D- The dialog for entering the IP address will also be shown even

Tie when connection to the Storage Server failed.

Use Viewer only without connecting to Storage Server
(Viewer Only Mode)
You can use the Viewer only without connecting to a Storage Server. When Storage

Server is not used, some functions such as video recording, sensor events, motion
detection, and event search are not available.

1 Select Not use Storage
Master Sterage Sener Server from the drop-down
Serve Cancel

menu.

2 Click Connect.
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Starting the Viewing Screen

You can
hide these
panels via
the View
menu

(— P. 15).

Viewer Start-up Window

When you start the VK-64/VK-16 for the first time and/or no Layouts have been
configured, you will notice that the Viewing Area is blank as shown below. Previously-
configured cameras on the network will appear as thumbnail images in the Camera
Selection Area on the top of the screen. These can be dragged onto the Viewing Area for
monitoring. If your Administrator has already created a Layout for you, then the Viewing
Area will display the first Personal Layout (or first Shared Layout if there are no
Personal Layouts) as shown in the example on the previous pages.

2, Network Video Recorder ¥K-64 - Storage Server

=10l x|
Fle Edt Yiew Help
Location Checkout Area
Zone

12! Default Personal Layout

Front Entrance

Click IE to maximize the
Viewing Screen.

<«———— Viewing Area

{ No Ca... Zoom In Zoc Out A Ewve h Jumnp to Time Return to Live &




Viewing Screen Menu bar

Menu Bar Functions

Z, Network Yideo Recorder YK-64
File Edit

Yiew Help

Screen menus.

The following table lists the Viewing

Menu Menu sub-item Function
File Switch Master Storage Server | Switches among Master Storages Servers. The connect option menu for
Storage Server is displayed.
Exit Closes the application.
Edit Cut In the Viewing Screen, this removes selected Video Windows from the
current layout and places to the Clipboard. You can paste these Video
Windows onto the same or another layout.
Copy In the Viewing Screen, this copies selected Video Windows from the
current layout and places to the Clipboard. You can paste these Video
Windows onto the same or another layout.
Paste In the Viewing Screen, this action pastes the cut or copied Video Window
into the current Layout.
Delete In the Viewing Screen, this deletes selected Video Windows from the
current layout.
In the Storage and Camera Server Summary screen, this deletes
selected Storage Servers, Camera Servers, Locations or Zones.
In the Recording Schedule screen, this deletes selected Normal or
Special Day schedules.
Select All In the Viewing Screen, this action selects all Video Windows in the current
Layout.
Search Events The Event Search dialog is displayed.
View Configuration Selects the Configuration and Preferences Screen if the Viewing Screen

is open.

Viewing Screen

Selects the Viewing Screen if the Configuration and Preferences Screen
is open.

Full screen Hides the Menu Bar and Title Bar to allow more display room for Video
Windows. Clicking the Esc key restores the Viewer to its previous state
(i.e., before selecting the Full Screen mode).

Captions Hide/Show the captions of Video Windows.

Camera Selector

Hide/Show the Camera Selection Area.

Timeline

Hide/Show the Timeline Area.

Live Events

In the Viewing Screen, this action opens the Live Events Log at the
position and size that it was last open. A tick beside the menu item
indicates that the screen is open. Selecting the menu item again will close
the window and the menu item will be unticked.

Camera Control

Brings up the Camera Control Panel where you can set the viewing
position and zoom.
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Viewing Screen Menu bar

View Audio panel Displays the Audio panel to transmit or receive audio.

Status bar Shows or hides the captions of the status bar. The status bar displays load
information for the Viewer (i.e., total frame rate, CPU %, number of
displayed events, number of Video Windows).

Help About This action opens the About box featuring the startup splash screen with
version number.




Chapter p/

Working with Video Windows

This chapter shows you how to create Video Windows for viewing in the Viewing
Area and how to adjust camera angles.




Selecting Cameras for Viewing

About the Camera Selection Area

The Camera Selection Area is used to display thumbnails of all the camera servers. You
can select another set of thumbnails of currently-available cameras via the Location and
Zone drop-down menus.

® The Location drop-down menu lists the physical locations of cameras on the system.

® The Zone drop-down menu lists the groups of areas within each location.

Location Checkout Area Front Entrance

Fitt Street Mall =i

Zone

Chedkout Area ﬂ

When you select a location, its associated zones will be listed below.

About Camera Thumbnails

When a Location is selected, the thumbnail images of the Camera Servers registered in
that Location will appear. Depending on the number of cameras in the selected Location,
a scrollbar at the bottom of the Camera Selection Area can be used to scroll the display
of thumbnails.

Front Entrance

Thumbnail images can be dragged onto the Viewing Area to create Video Windows.

@ Locations, zones and thumbnails are configured and managed by
users with Administrator privileges. You must have Administrator

Note  privileges in order to modify settings.

-D- You can hide the Camera Selection Area to allow more display
wtd  space for Video Windows. From the View menu, select Camera

1 Selector to hide/show the Camera Selection Area.




Selecting Cameras for Viewing

Selecting Locations and their Zones

Selection is performed in the following order:

1

Select a
Location

Step 1: Select a Location from the drop-down menu

Location

Shopping Center
Mailing House

Warehouse
Car Park
Cinema Complex

—> | Select a Zone in|—> Click and drag

2 3

thumbnails to

that Location view live video

} Click the Location drop-down menu or on the down
arrow.

A list of pre-configured locations appears.

Click a location in the list. Zones for that list will
appear in the thumbnail section to the right.

SMOPUIA 03PIA UM Buryiom

Step 2: Select a Zone from the menu or thumbnail folder region

Location

Shopping Center hd

fone

Car Park Entrance
Cazh Register #1

Cazh Register #2

Fear Entrance

Alternatively, click the scrollbar
located under the Camera
Selection Area. Drag it to the
right until the desired Zone is
displayed.

Click the Zone drop-down menu or on the down
arrow.

A list of pre-configured zones appears.
Click a zone in the list.

Once a Zone is selected from the drop-down menu,
the Camera Selection Area for the selected Zone
moves to the left.

Checkout Area Front Entrance
l C e N —




Basic Video Window Functions

Creating, scaling and moving Video Windows

Once you have chosen a location and a zone, you are ready to view one or more cameras
in that zone. Camera thumbnail images are used to create Video Windows in the Viewing
Area. The Viewing Area can support multiple Video Windows for live monitoring and
viewing recorded video simultaneously.

Click and drag a camera thumbnail onto the Viewing Area

Click the thumbnail image and while
holding down the mouse button,
drag its boundary anywhere onto
the Viewing Area.

Release the mouse button. The
live Video Window with video
image will be displayed.

Location Front Entranl:e_
=1
When placed the thumbnail Zone
image, the Video Window is ST (|
re-sized and re_positioned (¥) Front Entrance Area

according to the Layout
Grid.

A selected Video Window is
highlighted.

E ould not connect to camera An error message will appear in the Video
Window if there is a connection problem.




Basic Video Window Functions

Re-size a Video Window

Move a Video Window

Click a Video Window to highlight it.
An arrow icon will appear in the
lower right corner. Click the arrow
icon and drag outwards. You can
also click on the other corners and
drag to re-size the window.

Release the mouse button when you
have reached the desired size.

@ Alternatively, click the Video
Window menu button and select
Video Display Size. Select Small,
Medium, Large, or Default from the
sub-menu.
A right-click action on the Video
Window will also bring up the same
menu.

Click anywhere on a Video
Window and drag it to any
position in the Viewing Area.

E ® For best performance on the Viewer, such as to view as many
Video Windows as possible, re-size the Video Windows to a

Note
480).

standard resolution (for example, 160 x 120, 320 x 240, 640 x

® When Video Windows that are other than a standard
resolution are displayed, the load on the computer CPU will be
high and Viewer operations may take longer.
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Basic Video Window Functions

Add more Video Windows

Click and drag other camera thumbnails onto the Viewing Area to create Video Windows
for monitoring. Your Viewing Screen could look like this.

2, Network ¥ideo Recorder ¥K-64 - Storage Server —[=] x|

Eile Edit VYiew Help

Location Checkout Area Front Entrance Carpark

Zhopping Mall s

Zone

Checkout Area e o

!_ Front Entrance and GCarpark

e Stil Frame @), Zoom In - €} Zoom Out & Event Search  Jump to Time = Extrs o Return to Live 3

-

Arranging Video Windows

There are various ways you can manage the layout of Video Windows in the Viewing
Area. Ask your System Administrator.

@ ® In the Viewer, the number of Video Windows you can display

simultaneously will depend on your video card, the resolution
and quality settings of the camera and the Live Video Viewing
Settings (frame rate) set in the Viewer Settings window of the
Configuration and Preferences screen.

® If the load on the computer CPU is high, Viewer operations
may take longer.

Note




Basic Video Window Functions

Selecting Multiple Video Windows

You can select multiple video windows easily. You can also move, cut, or copy multiple
windows simultaneously.

Selecting Multiple Video Windows

There are three ways to select multiple windows:

® On your keyboard, hold down the Ctrl key and click each
Video Window to select them.

® Click outside the Video Windows and drag a selection box
around the Video Windows you want selected, as shown
below. Only windows contained within the area of selection
are selected. Dragging around part of an image will not
select it.

@ If you wish to select all Video Windows, click Select All
from the Edit menu (or on your keyboard press Ctrl + A).

® Video Windows from different zones and locations can be
- displayed in the same Layout.

® You can copy and paste a multiple selection of Video
Windows at one time which can be pasted into and saved as a
new Layout.

Tip
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Video Window States

Video Window Properties include:

® Title bar - indicates name of camera, live or recorded viewing.
® Video display - displays live or recorded information.

® Pre-recorded video indicator - displays a time/date stamp in the title bar for recorded
footage.

® Event indicator - displays a colored bar across the top of the Video Window.

® Pan, tilt and zoom controls - when the Video Window is double-clicked or the Video
Window menu item, Get Camera Control is selected, controls appear to enable pan, tilt
and zoom.

About Video Window states

V.ide.o Windows can be di.splayg.d in the e 7T
Viewing Area according to their conditions:

Zone

Chedout Area ol ]

® Live - when viewing live video from a
Camera Server.

® Pre-recorded - displays pre-recorded video
from a Storage Server.

lﬂ Camera

Cash#
Live Events Log list

Double-click an event to view it in the
corresponding Video Window. The
Live Events Log opens automatically
when you launch the Viewer, if left
open in a previous session.

& Front Entrance

Pre-recorded

Click to view recorded footage in the
corresponding Video Window.

The full camera name/event may not display if you reduce the

size of the window.
Note




Video Window States

Each Video Window displays video from an
individual camera. Video Windows can be
re-sized, repositioned or closed.

® Title bar

The title bar consists of menu, camera name
and live or recorded status.

Recorded video

: Playback
10:68:20 F .

The lightning symbol in the lower
right-hand corner indicates live video.

® Pre-recorded Video
Indicator

For recorded video, the
time/date indicator may
not fully display if the
Video Window size has
been reduced.

When recorded video
is shown, the title bar
on a Video Window will
change from black to

gray. ‘
=] Lift#1 L 23/08/03 p

® Event Indicator

If the option for Operator
Notification has been set, a
color bar will flash on top of a
live Video Window when an
event occurs. The color
indicates the event priority.
The bar will flash for a pre-
defined time and then remain
steady for one minute until
disappearing. An audio alert
may also sound if pre-defined.

Color Priority
Red Highest

Orange High

Yellow Medium

Light Green | Low

Dark Green | Lowest
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Adjust Pan, Tilt and Zoom

Viewing Live Video - Adjusting Pan, Tilt and Zoom
This is done in one of three ways:

® Directly from within the Video Window
® Using the Camera Control Panel
® Selecting a Preset

E ® For a VB-C50FSi and VB-C50Fi, only zoom is available.
® If a fixed camera or an external camera such as VC-C50i is
connected to VB-C50i, you cannot use pan, tilt, and zoom
operations.

Note

Using the Camera Directly from within the Video Window

Double-clicking on a live Video Window.

Alternatively, click the down-arrow at the base of the Video
Window (or right-click on the window). A drop-down menu
will appear. Select Get Camera Control.

If the camera server is being used by the Viewers or
VBAdmin Tools supplied with the Camera Server, a “Can’t
get camera control” message will appear. You may have to
wait a few moments and attempt to get control later.

Move the mouse cursor around the Video Window.
Arrows will appear in the cursor position when you
have gained control of the camera. Click and drag the
cursor in the direction of the arrow for pan and tilt.
When you move the mouse cursor to the center of
the image, a zoom in or zoom out control will appear.

Hold down the mouse on “+” to zoom in.

“w

Hold down the mouse on “-” to zoom out.

When you have finished, select Release Camera Control from the Video Window menu.




Adjust Pan, Tilt and Zoom

@ o If you have camera contr_ol, you can only drag the window by
e clicking and holding the title bar.

® When you have control, the camera can be controlled either by
clicking or moving the mouse while holding the left button
down. The latter method provides finer control.

® If a control warning “Control will be lost in 10 seconds.”
appears, it means you have stopped making changes for 30
seconds and a 10 second countdown commences. To continue
control, click in the Video Window, i.e. use the controls.

® You can still manipulate a camera that is currently recording.
If the recording position has been set, the Camera Server will
return to that position after the Viewer release camera control.

Tip

Using the Camera Control Panel

Pan/Tilt controls. Click Clicking this button To display, select View > Camera Control

Set Night to nudge or (_:Iick and returns the camera from the menu bar, or click the Video
Mode. gogeggecnﬁnt'nuous to face the front. window menu icon (or right-click in the
' Video Window) to bring up a context menu

SMOPUIA 03PIA UM Buryiom

Control - Cameraf x|| and select Camera Control.

If a Video Window is not selected, the
preview window will be blank. Click on a
Video Window to control the camera.

You can control the pan, tilt, and zoom
operation using a panorama image. Click
inside the Panorama window to adjust the pan
and tile angles so that the clicked position
becomes the center of the image.
Alternatively, you can move or zoom in/out the
yellow scope to perform the pan, tilt, and zoom
operation.

- If the digital zoom is enabled by the Camera
Server, a boundary between the optical and
digital zoom is displayed.

Click this button to| Click this button When the Video
display exposure | to display white Window is selected, | - Click and drag the Zoom slider to perform the

control (— P. 28). | balance control click Get Control. zoom operation.
(— P. 29). Click Release ) . )
L If preset camera (_Ic_mtrol when Sclylr(\:tkrérlsa?\:tlt(()itg dzlzp)ﬂay extended camera
angles have been finished. P -9
set up by your Switch On and Off of
Administrator, they external device

will be available from  oytput of the camera.
a drop-down menu.




Adjust Pan, Tilt and Zoom

ﬁ When using the VB-C300, you cannot use Night Mode in the
following cases:

Note @ When Day&Night is set to Auto on the Camera and Video
Settings page

® When the Night Mode is set to Auto with a recording schedule

® Exposure Control ltems (when the Exposure Mode is Auto)
- /e Set the Exposure Mode to Auto (VB-

RS C300 only).
Auto 4 Auto:  Automatically adjusts the
exposure.

Backlight: s

Clicking this button enables high-level
backlight compensation.

Clicking this button enables mid-level
backlight compensation.

Clicking this button disables  Clicking this button enables
backlight compensation. low-level backlight
compensation.

® Exposure Control Items (when the Exposure Mode is Manual)

NposUrE Set the Exposure Mode to Manual (VB-
Manual | C300 only). . . .
Manual: Dragging slide bars adjust

, . . the aperture value, shutter
8 - ! . = speed, and gain value.

Shutter: 1f100sec 1 _._. 000
=ain: 256 1 —. 256

Drag each slide bar to adjust the
aperture value, shutter speed, or gain
value.




Adjust Pan, Tilt and Zoom

® White Balance Control Items

Cne Shaot YWHB

R Gain:

B Gain: 251

Drag each slide bar to adjust
each gain value.

To forcibly adjust the white balance,
capture a white object (e.g., a piece
of white paper) and click One Shot
WB.

® Other items

Focus: Speed Settings:

& Auko Pan [ Tilt: @

Switch between Auto Focus and Manual Focus.
Auto: Adjust the focus automatically.
Auto (for domes):

Select the White Balance mode from the
drop-down menu. The following modes
are available (VB-C300 only).
Auto: Automatically adjusts the
white balance.
Fluorescent:
Select this option when using
the camera under neutral
white or cool white
fluorescent lighting.
Fluorescent H:
Select this option when using
the camera under a day light
fluorescent lighting.
Mercury light:
Select this option when using
the camera under a mercury
lighting.
Sodium light:
Select this option when using
the camera under orange
light of a sodium lighting.
Halogen light:
Select this option when using
the camera under a halogen
or incandescent lighting.
Manual:Drag each slide bar to adjust
each gain value (R or B
gain).

Select from Slow, Normal, and
Fast for Pan and Tilt.

Select from Slow and Fast for
Zoom.

When the optional dome housing is used, select this option to automatically adjust the

focus without focusing on the wall surface.
Fixed at Infinity:
Focus is fixed at a point of infinity.

Manual: Press and hold Far or Near button to adjust the focus. Clicking One Shot AF adjusts the

focus just once automatically (VB-C300 only).

SMOPUIA 03PIA UM Buryiom



Adjust Pan, Tilt and Zoom

E ® When you have finished, select Release Camera Control from
the active Video Window menu.

® Panorama image needs to be set on the Camera Server in
advance. VB-C50FSi/VB-C50Fi cannot display panorama
image.

® Exposure can be adjusted for VB-C300 only.

® White balance can be adjusted for VB-C300 only.

Note

Selecting a Preset Camera Angle

If preset camera angles have been set up, they will be
Widen Receive Size s available from the Preset drop-down menu of the
Camera Control panel or a sub-menu. The following
explains how to select a preset from a sub-menu.

mek Camera Cankaol

Release Camera Conkrol

Zamera Conkral Double-click a Video
Preset Camera Angles 8 Freset 1 Checkout Area 1 Window or select Get
Backlight Compensation »  Preset 2 Corridor West Camera Control from the
Night mode »  Preset 3 Corridor East Video Window menu.
. Preset 4 Entrance
Zonkral Exk | O ] . .
HLrof External LevIces | 2 From the Video Window
S o R b menu, click Preset Camera
Angles.
3 Select a preset position
from the sub-menu.




Other Video Window Functions

Changing the size of a Video Window

Apart from manually clicking on the corner and dragging out the Video Window to a new
size, you can also select a set size from the Video Window menu.

To change the display size of a Video Window via the menu:

Open the Video Window menu and select Video Display Size

@ Video Display Size Small

Widen Renehie SiEe ¥ Medium
Large

Raw

Click the Video window menu icon, or
right-click in the Video Window to bring
up a context menu.

Select Video Display Size from the
menu, and then select Small, Medium,
Large, or Raw from the sub-menu. A
Raw selection displays the Video Window
selected at the Video Receive Size.

Changing the size of a Received Video (VB-C50i/VB-C50iR,

VB-C50FSi, VB-C50Fi only)

You can select a video size received by the Viewer. To change the size of received video

via the menu:

Open the Video Window menu and select Video Receive Size

@ Yideo Display Size » |

Small

Mediurm

Large
» Default

Click the Video window menu icon, or

right-click in the Video Window to bring

up a context menu.

Select Video Receive Size from the
menu, and then select Small, Medium,
Large, or Default from the sub-menu.
Selecting Default displays the Video
Window in the size received from the
Camera Server.

E ® When multiple Video Windows from a single Camera Server
are displayed and the Video Receive Size is changed from one

Note

of them, the change will apply to all Video Windows.

® Seclected video receive sizes are saved when the layout is

saved.

® The Video Receive Size used for Default is determined when
connection with Camera Server starts. Even if you change the
size from the Camera Server after the connection is made, it

will not apply.
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Other Video Window Functions

Enabling Backlight Compensation

Backlight compensation is a camera feature used to compensate for camera views with
strong backlighting, i.e., viewing a dark image against a strong backlight. It can be enabled
from the Video Window menu. It is not to be confused with Shade Correction.

To enable backlight compensation:

While Camera Control is active, select Backlight Compensation

Click menu bar of the Video window, or

I " I 1 right-click in the Video Window to bring
Backlight Compensation  » i el up a context menu.

Might mods FooOn 2 Select Backlight Compensation from
Conkral External Devices  k the menu and select Off, or On from

the sub-menu.

Preset Camera Angles b

Backlight Compensation  + CRe; —You can set the backlight compensation to
Might mode Fo Low Off, Low, Medium or High for VB-C300,
Control Exkernal Devices * Medium VB-C50i / VB-C50iR, VB-C50FSi and VB-

High CS50Fi.

@ If Low, Medium, or High is selected, the tick (black dot) is not

displayed.
Note play




Other Video Window Functions

Other Menu Options

Other functions available from the Video Window menu include:

Click Night mode and select Disabled, Enabled,
IR light off, or Enabled, IR light on from the sub-
menu.

Selecting Enabled, IR light on will remove the IR
cut filter and turn the built-in IR light on. The IR light
EackidbEConnenaationak cannot be used with the VB-C300, VB-C50FSi, or
Might mode 3 VB-C50Fi.

Conkral External Devices

Click Control External Devices to control any
external devices that may be connected to your
Camera Server. This is only enabled when you have
camera control. For more information on external
devices, ask your System administrator.

Shade Correction »

Admin Yiewer

SMOPUIM 09PIA UYim Buiyiopy

Shade Correckion ' —Click Shade Correction to correct shaded

Gdmin Yiewer — Loy areas in the Video Window. This affects the

Audin Panel — Mediurn individual Video Window on display, i.e., any

] High duplicate (unselected) windows are not

Close Window Yery high affected. This is discussed on the following
page.

— Click Admin Viewer to activate the WebView Livescope Admin Viewer
if the Admin Viewer or NC Viewer is installed. For the VB-C300, the NC
Viewer is activated. Refer to your Camera Server User's Manual for
more information on the Admin Viewer or NC Viewer.

L Click Audio Panel to display the Audio Panel (— P. 34) when you want
to use the audio function of the VB-C300, VB-C50i/VB-C50iR, or VB-
C50FSi. Refer to your VB-C300, VB-C50i/VB-C50iR, or VB-C50FSi
User’'s Manual for more information on the audio settings.

— Click Close Window to close the Video Window that is currently selected. You
can also close a selected Video Window by pressing the Delete key.




Other Video Window Functions

E ® It is recommended to install the Admin Viewer and/or NC
Viewer in advance.

® The camera server which is sending or receiving audio cannot
interact with other viewer or Admin Viewers.

® Shade Correction cannot be applied to multiple Video
Windows.

® Shade correction is performed by using image processing
within the Viewer and not on the Camera Server. It can be
used on live or recorded video (see below).

Note

About Shade Correction
Shade Correction compensates darker regions of images and makes them lighter.

Correction only applies to the
displayed Video Window in
the Viewer.

Shade Correction Off Shade Correction High

Darker regions are most affected by Shade Correction.

About Audio Panel

g x|

Clicking this button after selecting a
@ | D s Video Window, or selecting a Video
—— Window after clicking this button starts

/D | 0,00 kKbps audio playback.

—_ Play audio also when using the

| microphone I—Clicking this button after selecting a
ﬂg Video Window, or selecting a Video

Window after clicking this button starts

. ! . I
When ticked, audio Click this button to . L
audio transmission.

is played back even display silent detection
when a microphone control.
is used.
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 Silence Detection

[\ Use silence detection ko reduce netwark braffic

—& [Use the defaulb seqsibivity sething

€1 St the sensitivity: manually

Lo | High
o -

1
Tick this option to Tick this option to
detect silent intervals manually adjust the

with predefined detection sensitivity.

sensitivity. Drag the slide bar to
adjust the detection
sensitivity.

When ticked, silent intervals are
detected while transmitting audio. For a
silent interval, network load can be
mitigated by reducing data to transmit.
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Chapter R,

Using the Timeline and

Viewing Events

This chapter shows you how to use the Timeline for live and
pre-recorded viewing as well as view and search events.

If you are using the Viewer only,

you can skip this chapter.




Using the Timeline

Timeline Overview

On the Viewing Screen, a timeline of past events associated with displayed cameras is
shown in the Timeline Area (— P. 8) at the bottom of the Viewer as colored bars. Selecting
a colored bar moves the Playhead to the event and the associated Video Window is

switched to playback mode.
Click to save the current image
on a Video Window in a file.
Click to Zoom in
Camera Name A manual recording or out of the

Video Window The name of the  with duration of one | Timeline to or
Playback controls  camera currently minute is initiated. less.
selected.

Click to scroll back Darker areas indicate
hours, by days or by recorded video for this
weeks. period.

Events for non-selected cameras
(Video Windows) in the Viewing Area
are in weaker colors indicated as
secondary event.

Playback controls Playhead region

CIRIKIEE DD

Previous Event

Rewind
Nudge Back
Play/Pause

Nudge Forward Click in this area of

Fast Forward the Playhead shaft
and drag to positions

Next Event on the Timeline.




Using the Timeline

Monitoring Live Video in relation to the Timeline

When a Video Window is created from a camera thumbnail, video is seen live. The
Playhead (shown below) will be in a “live” position. The “live” position represents the
present time. The Playhead remain fixed as time scrolls to the left underneath,
representing the passage of real time.

Click to search for  Click to jump to a Click to extract a Click to return the
past events. specified date/time.  segment of video to F’.layheac.i_to th_e.
save as another file. Live position (if it

has been moved).

m In {EJ. Zoom COut & Ewent Search  Jump to Time ™ Extract Wideo  Return to Live =

Click the time bar and drag to Click to scroll
scroll through the Timeline. forward hours, by
days or by weeks.

Events associated with Event display area Day indicator

selected cameras (Video
Windows) in the Viewing
Area are indicated in
stronger colors as
primary events.
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Priorities are color-coded as follows.

Color Priority
Red Highest
@ If no cameras are selected, all events are
N shown as primary events. Orange High
ole
Yellow Medium
@ You can hide the timeline by de-selecting Light Green | Low
Ti Timeline from the View menu. Dark Green | Lowest




Using the Timeline

Using the Timeline to check, play and extract video

You can view pre-recorded video by moving the Playhead control in the Timeline or
entering a timecode and jumping to it. Methods include:

Use the Playback Controls

You can control to play, rewind, fast forward or jump
A RAIAL Il > (¥ M to previous and next events (— P. 38).

The fast forward and rewind speeds change by 1x,
2x, 5x and 10x each time you click the buttons.

-D- Videos recorded at different times can be played back

w¥  simultaneously. First select a Video Window and move the

TP Pplayhead to start playback. Next select another Video Window
and move the Playhead to another time. This is ideal for
comparing the same or different cameras at different times.

Drag the Playhead to a new time

Click and drag the Playhead shaft to another location.
When you move the Playhead, you are effectively
controlling all Video Windows that have been selected.

Click in the Event Display Area of the Timeline

Click in the Event Display Area of the
Timeline. The Playhead will move to that
location and playback of recorded video
commences from that time.

E ® When you choose to play back video, the video is played over a

network. Therefore the response and smoothness of the play back

Note will depend on network traffic and other properties of the network.

® The time displayed on the Timeline is the time of PC where the
Viewer is running.




Using the Timeline

Click and drag the time bar to move through the Timeline

Move your mouse pointer over the time bar and it
becomes a hand. Click and drag to the left or
right to move back or forward in time. You can
only scroll right to the current time, or “live” time.

Jump to Time

1 Select a Video Window and click Jump to Time.

Mon Tus ed Thu Fri Sab Sun
26 27 28 29 30 1 z2
3 4 5 3] 7 g o]
11 12 132 14 15 16

x| 2 The Jump to Time dialog opens. Select a c
Enter & date and time to display day and/or t|me g'
Q@
Ciick OK. 2
Mon Tue Wed Thu Fri Sat Sun 3 ¢'=D-
P The Playhead and Timeline will move to =

o 11 12 13 14 15 16 H H H
B 15 10 2 2 m om the time selected. If no Video Windows are g
24 25 26 27 28 29 30 H H H =
P selected, only the timeline is moved. 5
Today: 17/05/2006 . ) ®
Using the calendar is shown below. 8
Time: | Lon:szPM = oy
ot _| 5
g
=
Q@
Click to scroll back — | May 2006 = Click to scroll forward m
through the months. through the months. o
-
(7]

AEF T 1T 0 o1 22 23 Click a day to highlight
4 25 P ZF PR M a0 It, then click OK to
a1 1 7 3 4 g & bringlup that day in
Today: 17/05,2006 the Timeline.
Time: | 1:01:32pM =2 Click up/down arrows
E= to select a ti
o select a time or
Alternatively, click the click each time
current month and a segment and
month selector will overwrite existing

appear. value.

January To select another year,
February click the current year and
scroll down or back up,

Match '
| using the up/down
arrows.

n Auguslk, = u




Using the Timeline

Initiating a manual recording with duration of one minute

A manual recording with duration of one minute can be initiated at the maximum frame
rate. The manual recording is displayed on the Timeline and Live Events Log as “Manual
recording (username)”. This is handy for capturing random events not associated with
sensor recording or outside preset recording times.

To initiate manual recording:

Select a Video Window for
manual recording.

I : i 2 Click Record Now.

Dpture Stil Frame @&, Zoom In | € Zoo 1

E ® The Record Now function records at the maximum frame rate.
Extended recording time will use additional disk space on the
ne Storage Server. Excessive use of this function should not be
performed without first checking with an administrator.
® The Record Now function is only enabled if a Storage Server is
configured for the camera.
® Recording will be for approximately one minute. The actual
duration of recorded video may vary depending on settings
and network delays.
® The priority of an event created by a manual recording using
Record Now will always be Priority 1. It cannot be changed
from Event tab.

Capturing a Still Frame

Click Capture Still Frame to save
the current image on a Video
Window.

ure Stil Frame )@, Zoom In | & Zoom out | &

Select a Video Window to
capture a still image.

1

o Click Capture Still Frame.




Using the Timeline

Zooming In and Out of the Timeline

@, zoorn In @ Zoorn Out Click Zoom In to zoom into a time period in the Event

Display Area.

Click Zoom Out to zoom out a time period in the
Event Display Area.

Click event to select it

==t e R e = s e Sl When you click an event

-

Click A time segment with darker color

event to
select it.

Ertry1: Disk space on drive D warning 9:532:24 &M

to select it, the associated

indicates that recorded video Video Window will display
exists for that period. the event(s).

Move mouse over event to get details.

Daylight Savings Indicator

The Storage Server will adjust for Daylight Savings if configured in Date and Time
property of the control panel as follows:

® When normal time has changed to Daylight Savings time, time that is skipped is

Camera Name

Type of event Time of event
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displayed in the Timeline as missing.

® When gaining time (rewinding the clock back from 02:00 to 01:00), the extra time is
duplicated.

Skipped Time

Duplicated Time.-\_.._.,

Where Daylight Saving changes have occurred, the Timeline
display is still continuous. Only the labels are affected.




Using the Timeline

Extracting video to save to another location

A portion of video can be saved to another location if required. Files are automatically
saved as QuickTime .mov format and can be viewed in a QuickTime player or any other
player that supports .mov files. A maximum of one hour of video can be extracted at a
time. If you do not have a QuickTime player installed, visit http://www.quicktime.com for a
free download.

Select a Video Window and time period then click Extract Video

Click a Video Window to highlight it, then click and drag

L “TFaC |“|' =10 . . g e . .
i Extract Yideo 1 a time period for it in the Timeline.
2 Click Extract Video. The Extract Video dialog opens.
x| 3 In the Date: field, cIic.k eaF:h
segment and overwrite with
Extract video From camera blah desired date_ A|ternative|y
Date: |25I05I2006 v[ click the down arrow to use
e IID:21:26 = IID:21:26 — the calendar.
4 In the From and To field,
ok | _ cacal | click the time segments and
overwrite with desired time,
or use the up/down arrows.
B = 5 Click OK to display the
6| - @EE Save As dialog. Browse to
a suitable folder in which to
save the extracted video,
and click Save.
i | s
N T —

@ ® You must select only one Video Window to extract video.

Note @ QuickTime player version 6.5.1 or later is recommended.

Returning to Live Video

To return to the live video, click Return to Live —. The Playhead

Return to Live
eturn to Live returns to the live position in the Timeline.




Viewing and Searching Events

About Live Events Log list

The Live Events Log displays events that have occurred with one or more cameras after
the Viewer has been launched. Events are color coded according to priority. The Live
Events Log opens automatically when you launch the Viewer, if left open in a previous
session of VK-64/VK-16.

I Live Events Log =(i|:|| El
.n Camera Dake &, Time Location & Zone
3 Motion Rear Entrance 11/17/2006 09:53:21 Shopping Ctr Loading Zone
[
Qa
=]
3 Motion Rear Entrance 11/17/2006 09:53:21 Shopping Ctr Loading Zone ‘S..
=
@
=
3
-
5
(1]
4 b [
=
Q
Click and drag scroll bar to view events. To maximize, double-click title bar — .-?
or click the maximize icon. s
The bell icon is replaced by a dot icon when a
— the event is acknowledged by double clicking. m
<
@
=
-
]

Re-sizing the window to a custom size

- O] x| Click the corners or edges and drag
the window out to a new size.
Release the mouse button.

Location & Zone

Opping oading Zone When you launch the Viewer again,
the Live Events Log will retain the
size you selected.

Y

Only the most recent 200 events are shown in the Live Events

Log.
Note 9




Viewing and Searching Events

Displaying the Live Events Log List
To display the Live Events Log List, if it is not displayed:

Selecting Live Events from View Menu

Select Live Events from the View menu bar.
Live Events Log list opens.

Once selected, the menu item will be ticked next time you display it.

Overview of Alert Parameters

Acknowledgement status

Priority of the event (1:Highest, 2:High, 3:Medium, 4:Low, 5:Lowest)

Event type that has occurred

— Camera name where event occurred

— Date and time of event

Location and Zone

amera Date & Time Location é{ Zone

4 3 Motion Rear Entrance 11/17/2006 09:53:21 Shopping Ctr Loading

Acknowledging and Viewing Events

A new event entry will appear at the top of the Live Events Log list and will flash for a
defined period if configured. If Operator Acknowledgement is required, the event will flash
indefinitely if not acknowledged.

1 In the Live Events Log, double-click on the event to acknowledge it and view it in its
associated Video Window.

2 In the bottom right corner of the Viewer, click Return to Live — when you have
finished viewing the event. The Video Window will return to live viewing.




Viewing and Searching Events

Searching Events

If you have multiple events, you can initiate a search for a particular event via the Event
Search dialog.

To launch the Event Search Dialog:

Click Event Search

On the Timeline, click Event Search.

A& Ewent &

The Event Search dialog opens.

c
Enter a search start Enter a search end Fnter r'at kelyword o
date and time date and time or particutar 3
' ' events. Q
-
5 3
Ta search for events, enter pearch criteria below and click Search, | fele(t:t a :!
ocation
From: |8,|'21,|'2006 1 j |00:00:00 :‘ to |8,|'21,|'2006 |7vJ’|09:24:25 :‘ and Zone. ?l
Description: I 4 C=D
Where: IAII Locations j IAII Zones j L9 SeleCt a g
Event: IAII Events State:  |all States x| Priority: IAII Priorities j PFIOFIty 2
Search Stop Search _Select a g
state of 5
Search Results: event. ©Q
P | Event Carmera Diate & Time Location & Zone |'<|'|
— Select a 2
Motion Cash #1 8f23706 Pitt Street Mall 1st Floor type Of a‘
Door Bell Entrance 8f23706 eVent
Motion #3 '
— Search
Result
Display
Area
Wiew Event in Camera | Cancel I

Double-click an event to view it in the Video Window, or
click an event to highlight it and then click View Event
in Camera to view it.




Viewing and Searching Events

Selecting Criteria for Searching

When you initiate a search, certain criteria can be specified such as Priority, Location and
Zone on the network, a date range when the event may have occurred and a time period.

To initiate a search:

Step 1: Select a date and time range to search

Click in the From and To date panels and overwrite the existing entries for
month/day/year and time.

again.

Tue Wed Thu
26 27 & 29 30 031
2 3 4 5 5] 7 g

16 17 1& #Ee 20 21 22
23 24 26 27 28 29
0 03 12z 3 4 &
Today: 08,/22/2006

down arrow.

Step 2: Select an event keyword

Description: I

1_1 Alternatively, click the down arrow next to each date panel
to bring up the calendar. Click off the calendar to close it

In the Event Search dialog, you can also scroll through
9 10 11 1z 13 14 15 ~  time using the up/down arrows. Click an hours, minutes or
seconds segment to highlight it and then click the up or

In the Description field, enter a
keyword such as, “deleting”,
“recording”, “frames”, etc. Found
events will be based on your text

entry.

Step 3: Select a Location and Zone to Search

Where: All Locations j IAII Zones

=

From the Where fields, select a
Location and Zone from the
drop-down lists. Only events
within the location will be
selected.



Viewing and Searching Events

Step 4: Select a type of Event

Select a type of Event from the drop-down list.

Event: All Events j

Step 5: Select a State

Select a State for the event, whether it was On or Off during the
state: [alstates v period. Alternatively, select All States.

Step 6: Select a Priority

Select a Priority from the drop-down list.

Priority: [ all Priarities =l

Step 7: Click Search

When you have entered the day and time range, click Search to initiate the event search.
Events that are found will be listed in the window below. If necessary, stop a search at any
time by clicking Stop Search.
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Viewing found events

To view an event in a Video Window,
click the event to highlight it and click
View Event in Camera to view it in a
Video Window.

You can also double-click an event to
view it in a Video Window.

Clicking Cancel stops any searching
and closes the dialog.

UiewEventm Cancel |

When you have finished viewing an event in a Video Window,
click Return to Live — in the Timeline to return the Video Window -

to live viewing.

Note
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